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g Documents Directly
Chapter One:
overview
Each CaseFinder system contains the full text of hundreds of thousands of legal
documents. All of the documents are completely indexed. The CaseFinder program uses those
indexes to find and retrieve documents for you which contain the words you specify in a
"search request." CaseFinder does not make any judgments about which documents to
retrieve; it only does what you tell it, as fast as it can. You need to have a basic understanding of Windows to run CaseFinder.

The Structure of CaseFinder
CaseFinder is composed of three elements: (1) a text-search-and-retrieval program, (2)
archive files containing the full text of documents, and (3) indexes which contain every word,
and the location of every word, in all the documents (except for 148 "noise" words).
Item (1) can be likened to a research librarian on steroids, item (2) to shelves and
shelves of books, and item (3) to an extremely detailed card catalogue. Under this analogy,
you would tell the research librarian that you wanted to find decisions containing a particular
word. The librarian would find the card in the catalogue for that word, and the card would
identify all of the decisions in all the books on the shelves that contained that word. Then the
librarian would retrieve all of those books, open them to the right case or statute, highlight the
word in the text that you had specified, and put them on the table in front of you — in a few
seconds.
In the simplest form of operation, you provide CaseFinder a word, it looks in its indexes
to find which documents contain that word and then lists those documents for you. When you
select a document from the list, CaseFinder retrieves it from the archive file and displays the
full text on your computer monitor.
A "database" consists of archive files and an index. Each database covers the decisions
of a particular court, a statutory compilation or the work product of a government agency.
Each database is contained in a separate folder on the CD.

Assumptions About Your Windows Ability
This User’s Manual assumes that you are familiar with the general operation of Windows; that you know how to use a mouse and keyboard; that you can activate applications
from the Start Menu; that you can select menu items; that you can open either My Computer
or the Windows Explorer and navigate within it; and that you can operate the standard
Windows buttons and scrollbars. The screen shots in this Manual were all taken from
CaseFinder running under Windows Vista.
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Conventions Used in This Manual
In this Manual, “Alt” refers to the Alternate key and “Ctrl” refers to the Control key on
your keyboard. These keys are always used simultaneously with some other key; while
depressing the Alt or Ctrl key, you press another key, then release both. Holding down the Alt
key and pressing the S key is represented in this Manual as follows: <Alt-S>.
The words "and", "or" and "not" are often used to refer to connectors entered into search
requests. When used in that sense, they will appear in small capitals in a bold font: AND, OR
and NOT

CaseFinder's Help System
CaseFinder has a built-in Help system. The items on the Help Menu include:
What's This? changes the appearance of the pointer, then you move to an item on the screen
and click on it to get information about it.
Contents opens the Help System at the "Contents" tab where major topics are listed; doubleclick for more specific topics.
Search opens the Help System at the "Index" tab where an alphabetical list of topics appears;
type in a letter to jump ahead in the list.
Read Me accesses the latest readme.txt file from the CaseFinder CD, which lists information
about revisions and bug fixes in the current version of the CaseFinder program.
Tip of the Day appears at the bottom of the screen every time you start CaseFinder; this Help
item lets you browse through the entire Tips database.
About lists copyright and version number information, and provides access to the Permit
generator.

Help via the Internet
Go to the CaseFinder public website at www.casefinder.com and choose the Support
menu for in-depth technical explanations of specified topics or e-mail tech@casefinder.com.

Toll-Free Tech Support
Technical support is available from 10:00 am to 5:00 pm EST/EDT, Monday through
Friday, at (800) 457-6045. Please consult the built-in Help system, this User’s Manual and our
website before you call; most questions are answered in those sources. In addition, it has been
our experience that even though CDs are very durable and scratch-resistant, CD-ROM drives
have trouble reading through smudges and/or fingerprints on the shiny side of the CD. Thus,
before you call Tech Support, try spraying a little glass cleaner on the CD and wiping it with a
soft cloth or paper towel and re-running CaseFinder.
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Chapter Two:
Installation and Updating
System Requirements
CaseFinder runs under Windows Vista, XP, 2000, 98, 95 and NT 4.0. CaseFinder requires a
133 Mhz or better processor, 96 MB of free RAM, a CD-ROM drive, and at least 15 MB of free
space on the hard drive. Though not required, we recommend a display resolution of 800 x 600
or higher.

Installation, Generally
CaseFinder must be installed by using the setup program on Disc One, which copies
programs from the CD to your computer, records information in the Windows registry, puts
CaseFinder in your Programs Menu and places a shortcut on the Desktop (if you choose). The
databases can remain on the CDs or you can transfer them to a hard drive at the time of installation, or at a later date by using the maintenance functions in the setup program. Instructions
follow for installation on a standalone computer and two types of network installations.

Licensing Considerations
Our license agreement allows the user to run CaseFinder on only one computer at a time,
even though it may be installed on many computers within a single entity. The software enforces this limitation; CaseFinder will not start unless: (1) a CaseFinder Disc is in an accessible
CD drive; or (2) a concurrent use permit is available in the folder where the CaseFinder program
is installed. Thus, you may install the CaseFinder program on multiple computers, then simply
put one of the Discs in the drive of whichever computer needs to run CaseFinder. However, if
you install the CaseFinder program from the CD to each of the workstations on a network and
then put the CD in a shared CD drive, it won't work. When CaseFinder starts, it "knows"
whether the program file was loaded from a local drive or from a network drive. If CaseFinder is
loaded from a local drive, it will only access databases from local CD or hard drives. In order to
share the databases from networked CD drive(s) or networked hard drives, the CaseFinder
program must be loaded from a network drive. To do this, you must install CaseFinder to a
folder on the network's file server; this process will place a workstation version of CaseFinder
on the file server, and that version can be installed to the workstations across the network.

Concurrent Use Permits
Concurrent use permits allow more than one computer to access CaseFinder simultaneously. For example, assume CaseFinder is installed on the file server of a network with two
workstations. Workstation "A" starts CaseFinder. If workstation "B" then tries to run
CaseFinder, it will get a message saying that CaseFinder is in use. If a concurrent use permit is
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installed on the file server, then both A and B can run CaseFinder at the same time. A concurrent use permit also eliminates the requirement of having a CaseFinder Disc in the CD drive to
run the program. Thus, if you transfer all of the databases to the hard drive of a computer and
install a concurrent use permit, you won’t need a CD in the drive to start the program.
Concurrent use permits are licensed and cost much less than an annual subscription. To
obtain and install concurrent use permits, start CaseFinder, go to Help > About and click on
Permits. Call us at (800) 457-6045. You'll read us a code number, tell us how many permits you
need and for what period of time and arrange for payment. We'll read you back a code number
to enter into CaseFinder, and it will generate the permits.

Installing CaseFinder on a Standalone Computer
1. Start Windows. Close any open programs.
2. Place Disc One in your CD drive and close it. If Autorun is enabled, a message will
state that an installation “wizard” is being prepared. If nothing happens, navigate to the root
directory of the CD and double-click “setup.exe.” Alternatively, click Start > Run, enter
d:\setup (substituting the letter of your CD drive for “d” as necessary) and click OK.
3. When the Welcome screen appears, read it, then click Next. The CaseFinder license
agreement will appear; scroll down to read the entire agreement (click Print to make a hard
copy if desired). You must accept the terms of the license agreement in order to continue with
the installation; click Yes to do so. If you click No, the installation will terminate and nothing
will have been copied to your computer.
4. A Choose Destination Folder screen appears, suggesting "C:\Program
Files\Casefinder." Click Next to accept this location (this is where tech support will expect to
find it). If you really, really want to install the program in a different location, click Browse,
navigate to the desired location, select it, click OK, then click Next.
5. You will be asked if you would like to transfer any databases to the hard drive. You
don't have to, but you should. If you leave all the databases on the CDs and access them from
a single CD drive, (1) searches will be slower, and (2) you will have to manually swap CDs
whenever CaseFinder needs to access a database from another CD. If you have enough room
(the installer program will tell you), you can transfer all the databases from the CDs to the hard
drive. However, even if all the databases are on the hard drive, one of the Discs must still be in
the drive for CaseFinder to run (unless you install a Concurrent Use Permit, see above). We
recommend that you at least transfer all the databases from the Disc that you will use the most,
and leave another Disc in the CD drive. Note: If you subscribe to CaseFinder, when you update
the system with each month's set of Discs, CaseFinder recognizes which databases were
transferred to the hard drive and automatically updates them if necessary.
If you click Yes, a list of databases appears, showing which Disc they are on. Below
that, the name of a “Data Folder” is suggested; folders will be created under the Data Folder
to hold database(s) that you select for transfer. To choose a different Data Folder, click Browse
and navigate to the desired location, then click OK to return. Click to place a checkmark in the
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box for each database you wish to transfer. As you do so, the total amount of data to be
transferred will be stated at the bottom of the screen, just above a statement of the available
free space. When you're done, click Next.
6. A Program Folder for the CaseFinder program icon is suggested; you can specify a
different location if you wish. This is where the Program icon will appear in the Programs
menu at the Start menu. When finished, click Next.
7. You will be asked if you want to have a CaseFinder shortcut placed on your Windows desktop. Click either Yes or No. The installation will begin, and a progress bar will
appear. If you had chosen to transfer databases to the hard drive, you may be prompted to
insert the other Discs as needed.
8. When the installer is done, an "Installation Complete" screen appears. You can
check option boxes to view the Readme file and run the CaseFinder program. Then click Finish.

Network Installations, Generally
There are two types of networks: (1) “client-server” networks which incorporate at least
one central computer (“server”) from which connected workstations (“clients”) can load
programs, access files and utilize shared hardware devices; and (2) “peer-to-peer” networks in
which no central computer acts as a dedicated server, but all connected computers can share
programs, files and hardware devices. CaseFinder has been tested on both types. The
installation instructions which follow are for the client-server network model.
Geronimo provides free tech support for problems related to the CaseFinder
program and databases; we can recognize the symptoms of network problems which will
prevent CaseFinder from operating correctly, and advise you accordingly, but we will
not perform network analysis or troubleshooting.
The administration of a computer network is significantly more complex than is
generally realized. Often, organizations employ third parties to install their network, but fail
to realize the importance of hiring or training a qualified administrator to perform the
necessary maintenance. Thus, a great deal of our tech support time in the past was taken up,
not in troubleshooting CaseFinder, but in troubleshooting the customer's network. While we
can certainly sympathize, we will not be able to continue to provide free tech support for our
program if all of our time is taken up in correcting problems that are properly the responsibility of the customer.

Installing CaseFinder on a File Server from a Workstation
These instructions assume that all of the database files will be transferred from the CDs
to a hard drive on the file server. If some or all of the databases will not be transferred to the
server's hard drive, see the next set of instructions, beginning on page 6.
1. From one of the workstations, access a directory on the file server that is read/write
accessible by all the workstations that are to run CaseFinder. Create a "Casefinder" folder in
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that directory (you can use a different name, but our tech support people will expect to see
"Casefinder"). We will call this the "application folder" in these instructions.
2. Put Disc One in the CD drive of the workstation. It should autorun to an InstallShield wizard and from there to a welcome screen. If not, go to Start > Run, type in the
local CD drive letter followed by ":\setup" and click OK.
3. Click Yes or Next until you get to the Choose Destination Location screen. The
installer will suggest "c:\program files\Casefinder" as the application folder, but that refers to
the local c: drive, which you don't want. Click Browse and navigate to the application folder
on the file server that you created in step one; when it shows up in the "path" box, click OK
and you will return to the Choose Destination Location screen. Click Next.
4. You will be asked if you wish to transfer some or all of the CaseFinder databases
from the CD to the hard drive. Click Yes and then click in the check box of each database that
you wish to transfer. A folder will be created under the application folder for each database and
the database files will be transferred into those folders at a later point in the program. You can
use the Browse button to choose a different location for the database folders if you wish. Click
Next when you're done.
5. A screen will suggest a Program Folder to hold the CaseFinder icons; click Next.
6. You will be asked if you want to create a shortcut on the desktop; click Yes.
7. The installer will proceed to copy files, displaying a progress bar. It will prompt you
when it needs Disc Two and Three.
8. A screen will ask if you want to run CaseFinder or view the Readme file; decline and
click Finish. You may be asked to re-boot the computer. (Go to "Workstation Setup" on page
7.)

Installing CaseFinder on a File Server from the Console
1. Using the keyboard, mouse and CD drive of the file server itself, open Explorer and
create a "Casefinder" folder on a drive that will be accessible to all of the workstations from
which you want to run CaseFinder (see instruction 3).
2. Put Disc One in the CD drive of the server. It should autorun, prepare an InstallShield wizard and then display a Welcome screen. If not, go to Start > Run, type in the
CD drive letter followed by ":\setup" and click OK.
3. Click Yes or Next until you get to the Choose Destination Location screen. The
installer will suggest "c:\program files\Casefinder" as the application folder. You probably
don't want to put shared applications such as CaseFinder on the c: drive of your file server.
Click Browse and navigate to the folder that you created in step one; when it shows up in the
"path" box, click OK and you will return to the Choose Destination Location screen. Click
Next.
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4. You will be asked if you wish to transfer some or all of the CaseFinder databases from
the CD to the hard drive. Click Yes and a list of databases will appear. Click in the check box of
each database to be transferred. By default, a folder will be created under the application folder
for each database and the database files will be transferred into those folders at a later point in
the program. You can use the Browse button to choose a different parent folder for the
database folders if you wish (but see Note below). Click Next when you're done.
Note: If you will be accessing some of the databases from the CD drive in the file
server, you will need to open the paths.txt file in the application directory and add the drive
letter (or the UNC path) by which the workstations can access that drive. In addition, if you
transferred databases to the server’s hard drive anyplace other than under the application
directory, you will need to add that path also. (Follow instructions 5 through 8 on page 6, then
go to "Workstation Setup," below.)

Workstation Setup
1. From the workstation, go into Explorer, go to the CaseFinder application folder on the
server, locate the \Wksetup folder and double-click on setup.exe in that folder.
2. The program will proceed to install a version of CaseFinder on the workstation;
choose Yes, Next or Finish at all screens and don't select or change anything.
3. When the workstation setup finishes, double-click on the CaseFinder shortcut. The
program should open up to the Search Request Screen and the databases that are available
should appear in full color; databases that aren't available are "greyed out." If none of the
book icons are open, click on one of the case-type databases and wait for the book to open.
Type a simple word into the search request entry blank near the top of the screen and click
Start Search. A list of cases should appear; double-click on one and you should get the text of
the case. Close CaseFinder. Repeat this process at all the workstations.

Paths.txt
For CD tower or other setups with multiple database locations, modification of the
paths.txt file will be necessary. The file must include the fully-qualified path to each CD in
the tower, or other database location. Don't provide paths to individual databases; provide
paths to the “parent” of the folders which contain the databases.

Updating and Maintenance
A new set of CaseFinder CDs is issued to subscribers every month, adding recent
decisions and other information issued by the courts, agencies and legislatures. Place the new
Disc One in the drive from which the installation was performed. Run CaseFinder from the
computer (workstation or network console) from which the installation was performed; it
will see that the new disc has a later date and ask if you wish to update right now. Click Yes
and the setup program will run and will automatically update any databases transferred the
previous month. Each set of CDs completely replaces all prior CD sets (if you failed to perform
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last month's update, you can skip it and do this month's update). If a new database is added,
the cover letter accompanying the CDs will notify you, a message to that effect will appear the
next time you start CaseFinder, and the new database will automatically appear in the Database
list.
If you did not transfer databases from the CD to the hard drive at installation, you can
do so later. Run the setup.exe program from Disc One, and choose “Modify.” Place a check
mark in the boxes of all the databases that you want to put in the suggested Destination
Folder, even if some of them were previously transferred. If you don’t check a box, that
database will not be transferred, or if it is already in the Destination Folder, it will be removed. Then click Next. If you want to put other databases in a different folder, repeat the
process, this time selecting the other databases and specifying a different Destination Folder
by clicking on Browse and navigating to the desired folder.

Uninstalling CaseFinder
To uninstall the CaseFinder program (including all transferred databases), go to Start >
Settings > Control Panel, and double-click Add/Remove Programs. Click on CaseFinder in
the list of installed programs and click on the Change/Remove button. Installshield wizard will
be start and you will be asked to confirm the uninstall. You will be asked if you wish to retain
user settings and concurrent use permits. If you had created any notes relating to particular
cases or if concurrent use permits were installed, click Yes. Finally, click Finish to complete the
uninstallation. The workstation version of CaseFinder can be removed by following the same
process, selecting CaseFinder-Workstation in the list of installed programs in Add/Remove
Programs.
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Chapter Three:
A Simple Search Request
Though it has lots of bells and whistles, discussed elsewhere in this User’s Manual, it is
not necessary to learn complicated or elaborate searching techniques to get useful results
from CaseFinder. This Chapter shows you how to perform a simple search, so you can start
being productive with CaseFinder right away. When you’re comfortable with the basic
searching strategies, read the ensuing Chapters to learn about the more sophisticated
searching options available. Now, follow the numbered steps . . .

1. Start CaseFinder
One of the CaseFinder CDs must be in the CD-ROM drive you are accessing (local or
network) to run the program, or a concurrent use permit must be available to the program.
Click on the CaseFinder shortcut on your desktop, or choose CaseFinder from the Programs
Menu to start the program. A display screen will appear for a few seconds while the program
loads, after which the Search Request Screen, shown below, will appear.
The Search Request Screen is the main screen in CaseFinder. This is where you will
choose which database or combination of databases to search, enter search requests, view lists
of documents found, access individual documents from the Library or by using the Direct to
Document or Search Names features, store and retrieve search requests, and set searching
options.
MENU
ENTRY BAR

START SEARCH
BUTTON

TABS
CONNECTOR
BUTTONS

LIST OF DATABASES

SEARCH OPTIONS
SETTINGS PANEL

2. Select a Database
To perform a search in CaseFinder you must first open one or more databases. The names
of all of the databases in your CaseFinder system are listed in the first column of the “Databases” tab at the Search Request Screen. The date through which a database is current appears in
the second column, and, if the database is already open, the word "Yes" appears in the third
column. Depending upon how you installed CaseFinder, some of the databases may not be
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immediately available, usually because you are running CaseFinder from a single CD drive and
they are on one of the other CDs. These databases will be “greyed out.” If CaseFinder needs
them, you will be prompted to swap CDs or
provide a location for the database. Clicking
once on a database will open it; its “book” icon
will open (even if it is greyed out). Single-click
an open database to close it.
To keep this example simple, we'll search
on only one database, and that will be a database of judicial opinions. Here, we've selected
the database for the Va. Supreme Court.

3. Enter a Search Request
After you have selected a database, type in a “search request.” A search request
consists of a word, a number, or a pattern or combination of words and/or numbers. For now,
we won’t discuss what to enter; see Ch. 4, “Formulating Search Requests,” for help on that.
Rather, we’re only going to talk about the mechanics of entering the request.
A small, blinking, vertical line (a “cursor”) usually appears at the left edge of the Entry
Bar in the Search Request Screen. (If it isn’t there, press the Tab key until it appears, or click
in the Entry Bar.) Each letter you type on the keyboard will appear in the Entry Bar at the
location of the cursor. Text entry follows Windows conventions; typing is in “insert” mode,
meaning that any letters to the right of the cursor will be pushed over.
Here, we've started to enter a search
request on the word “aviation.” Upon typing
in the third letter, “i,” the Word List opened.
The Word List shows those words in the
selected database that begin with the letters
thus far entered. See Ch. 12, “Customizing
CaseFinder,” for Word List options. The Word
List checks spelling; it discreetly goes blank
when a typo is entered. Continue typing or
click on a word in the Word List to copy it into
the Entry Bar. Note: The Word List is not
functional when you are performing a multiple
database search.

4. Launch the Search
Start your search by pressing the <Enter> key, or by clicking on the Start Search button.
A small window appears with a little magnifying glass circling around in it, to amuse you while
CaseFinder examines the chosen database to find those documents which contain your search
request. If the search request finds any documents, it will be saved for the rest of the session,
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and can be permanently saved. See Ch. 5, “Power Searching."

5. Examine the Search Results
When CaseFinder has finished searching, the Search Results panel will open, listing the
documents that were found. In the space above the list, the number of documents found, the
databases that were searched and the search request are set out. By default, the documents
that satisfied your search request are listed in
reverse chronological order, i.e., the most recent
case is listed first (but see Ch. 6, “Additional
Searching Tools,” for other listing options). For
each document, the name, the citation and
number of “hit” words in the document are
listed. When a case is a slip opinion or is
unpublished (no volume and page number
available), the cite will generally use an
underscore (“__”) and/or a docket number.
Notice that the first document in the list is
highlighted in a selector bar. To view it, press
<Enter> or double-click on it with the mouse. To view a different document on the list, doubleclick on it, or move the selector up or down with the arrow keys and press <Enter>. When you
are viewing a document in the Document Viewer, you will not need to return to the Search
Results List to view the document preceding or following it; the Document Viewer has Next
Doc and Prior Doc buttons (see below).

CONTROL BUTTONS

PAGE INDICATOR

SOURCE OF DOCUMENT

NOTE INDICATOR

DOCUMENT
INFORMATION BAR

A HYPERLINK

6. View the Document
The Document Viewer (which you can resize or reposition with the mouse) displays the
full text of CaseFinder documents, however they might be accessed (search, Library, Direct to
Doc, Hyperlink, etc.). The text of documents is fully-formatted; centering and paragraph
indentation generally follow the print version, along with italicization for emphasis. Illustrations from the cases appear in the Document Viewer. Options let you display text in any font,
color and size you choose (see Ch. 12, “Customizing CaseFinder”). The Document Viewer
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also provides for printing, hyperlinking, copying and pasting fully-formatted text (through the
Windows clipboard or by dragging and dropping) into a word processor, finding text within a
document, and attaching notes to documents. However, in this chapter we’ll stick to the
basics.
By default, the text of a case is displayed from the beginning, showing the full “style” of
the case. The name of the case and its citation will always be displayed in the Document
Information Bar. The position of the case on the Search Results List (or other List from which
the document was accessed) is shown in the Source panel to the left of the Document Information Bar. The Note icon to the immediate right of the Document Information Bar will be
yellow if you have previously created a note for the current document. The Page indicator to
the far right shows the page upon which the first word in the first line of text at the top of the
screen falls.
To move up or down in the text of the case one line at a time, use the up or down arrow
keys, or click the small buttons at the top or bottom of the scrollbar on the right side of the
Document Viewer. To move up or down a screen at a time, use the <Page Up> or <Page
Down> key, or click in the grey area of the scrollbar, above or below the blinking “thumb.” If
your mouse is equipped with a wheel, moving the wheel scrolls the text (you can set the
sensitivity of the wheel — see Ch. 12, “Customizing CaseFinder"). To move quickly to a
page within a case, select Go To Page from the Tools menu, enter the desired page number,
and click OK.
To view the next or previous document
that was on the Search Results List, you don’t
need to return to the Search Results List.
Instead, click on the Next Doc or Prior Doc
button in the Document Viewer. This functionality works when you are viewing documents
from any List (as indicated by the Source
panel).
As you scroll through the text of a case,
notice that italicized words appear in the same
places as in the printed version. The text and
background appear in whatever colors you chose as a default for Window Text in the Windows Control Panel > Display. Word(s) from your search request will be highlighted in yellow
(or choose a color — see Ch. 12, “Customizing CaseFinder”). Citations to documents contained in the CaseFinder databases appear in bright blue text and underlined: these are
“hyperlinks” which we will discuss a little later on (again, you can choose the color and/or
whether or not they should be underlined — see Ch. 12, “Customizing CaseFinder”).

12

Seeing the Hits in Context
If the document was found in response to a search, the words from the search request
(the “hits”) are highlighted. The Viewer can be set to open at the top or at the first hit word
(see Ch. 12, “Customizing CaseFinder”). When the documents are set to open at the top, you
don't need to scroll through the text looking for hits — simply click on the Hits Down button
to jump directly to the next hit in the text. The Hits Down and Hits Up buttons are enabled
when there are any hits below or above, respectively, your current position in the text.

Hyperlinking Fundamentals
Citations to documents contained in the CaseFinder databases appear in bright blue and
are underlined; these are “hyperlinks.” Clicking on a hyperlink brings the text of the cited
document directly to the screen. When viewing a hyperlinked document, you can click on the
Back button to go directly back to the document from which you launched the hyperlink, at the
point in that document where you clicked on the hyperlink. The following screens show this
process.

1. Clicking on Va. Code § 8.01-275.1 in the
text of Berry v. F & S Financial Marketing
brings up . . .

2. . . . the text of Va. Code § 8.01-275.1. The
Back button is now enabled. Clicking on it . . .

3. . . . brings you back to Berry v. F & S
Financial Marketing, at the same place as in
illustration 1, above.
Many additional features are available in
the Document Viewer, including printing,
copying text, annotating the document,
searching within the document, using the
Keep List, using CitedIn, and using the
History List. All of these features are discussed in other Chapters of this User’s
Manual.
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Returning to the Search Request Screen
When you are finished viewing documents in the Document Viewer, you can return to the
Search Request Screen by clicking Return to Search in the File menu, by clicking the “X” box
in the upper right-hand corner of the Viewer window, by selecting “Search Request” from the
Window menu, or by clicking on the CaseFinder Search Request button in the System Tray at
the bottom of the screen.

Creating a Note
As you’re viewing a document, you may realize that something relating to that document
would be important to recall whenever you access the document in the future. Select Note from
the Edit menu, or click on the Note icon to open the Note Viewer.
Now, type in whatever you want. A Note can contain as much text as your hardware will
allow, but it will not contain any formatting information, other than “hard” carriage returns
between paragraphs. The Note Viewer uses the regular Windows typing and editing functions. When you’re finished typing, select Save from the Note Viewer's File menu to save the
note and close the Note Viewer. Alternatively, you can select Close from the Note Viewer's
file menu, or click on the “X” box in the upper right-hand corner of the Note Viewer. From
now on, every time you open this document, the Note icon will light up in bright yellow.
Let's say that a week later, you open the document in the foregoing example. The Note
icon lights up, indicating that you attached a Note to this document. To see what you said,
click on the Note icon. While the Note Viewer is open, all of the functions of the Document
Viewer can still be used, and the Note Viewer can be dragged around the screen. However, if
you switch to another document, the Note Viewer will close.
Notes can be edited using standard Windows editing procedures. Simply enter your
changes and click on Save from the Note Viewer's File menu. In addition, the Windows
clipboard works with the Note Viewer, so you can move text into or out of the Note. You can
also print or erase the note from the Note Viewer File menu.
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Chapter Four:
Formulating Search Requests
The results you get from CaseFinder depend upon the information you give it. The old
computer maxim “Garbage in; Garbage out” still holds. This User’s Manual concentrates on
showing you how to enter your search requests; what to enter is left up to you. In this
Chapter we will try to give you some guidelines on crafting useful search requests.

A New Way of Thinking
The approach we recommend might require revising some of your old research habits,
particularly if those habits were established prior to the introduction of on-line legal research
methods. You likely were taught to identify the substantive areas of the law in which a given
factual situation might fall (“If it walks like a duck, swims like a duck, and quacks like a duck,
it’s probably a duck”). Thereafter, you would consult the general discussions in the legal
encyclopedias and treatises, following the thread into the more narrowly-focused subdivisions, and if you were fortunate, one of them would be right on point, and, if you were even
more fortunate, would contain citations to cases or statutes in your jurisdiction.
This traditional, topic-based approach had weaknesses. The editors who prepared the
digests and encyclopedias had to start with an outline which subdivided broad areas of the
law into a multitude of topics, with layers of narrower and narrower subtopics. They read and
analyzed a new decision to identify the legal issues covered, and tried to “fit” each issue into
one of the existing topics in their outline. If an issue didn’t exactly match any existing topic,
they either had to create a new topic or “wedge” it into the next-closest topic.
Classifying decisions by substantive areas of the law does not always identify the factors
in the case that are important to the outcome. Further, editors cannot know at the time they
classify a case what a later court might consider to be its most important holdings. The case
gets frozen into a particular category, even if the evolving body of the law would later place it
in some more appropriate category. The structure of the outline must be reasonably fixed to be
useful, but it runs the risk of becoming so rigid that it no longer covers the actual state of the
law.
By contrast, when you examine a database of documents with a search request, you are
looking only for matching words, without regard to any substantive classifications established
for the documents. You are defining the category into which they will belong, rather than
trying to decide which category some long-deceased editor may have decided to place the
case, based on the law extant in his time. Unlike the editors of the past, with electronic research
if your selection criteria do not produce useful results, you can modify them and do the search
over in a matter of seconds.
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Think Like the Author
Probably the best way to approach a research project in CaseFinder is to put yourself in
the position of a judge writing an opinion regarding the matter in question. Try to think of a
few unique words which a judge would necessarily use in writing that opinion, words which
would differentiate it from other opinions; word innate to the subject matter. These words, and
their relationship to each other, could form the basis of a search request that would find
relevant opinions.
Don’t use words that are too specific or too related to the facts. A number of cases
which discuss the relevant issues, even though they may arise from different facts, will be
more helpful to you than a few cases which involve the same facts, but different issues.
The AND connector is your friend. Using AND in a search request containing two somewhat general terms will be more productive than using an OR connector in a search request
containing two specific terms. The AND connector lets you use general terms, but narrows the
results of the search by requiring that they all be present in a document.
You haven’t found the kernel until you’ve found chaff all around it. If all the cases in the
results list from a search seem to be right on point, the search request is probably too narrow,
and you might be missing some relevant cases that broader search terms would disclose. It
isn’t until you’ve found at least some marginally-relevant or non-relevant cases that you can
be somewhat comfortable that you’ve found all the good stuff. In light of everything above,
and generally speaking, a search request should probably not contain more than four terms.
A thorough understanding of the use of the regular connectors (AND, OR and NOT), the
proximity connectors, the global replacement character (*) and the wild card character (?)
greatly enhances your ability to create effective search requests. It is highly recommended
that you study the portions of this User’s Manual dealing with those subjects.
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Chapter Five:
Power Searching
Chapter 3 of this User’s Manual told you how to enter a simple search request; Chapter
4 discussed some of the things you should consider when trying to decide what to enter. This
Chapter goes into detail about the process of entering a search request.

Words
“It is of interest to note that while some dolphins are reported to have learned English —
up to fifty words used in correct context — no human being has been reported to have learned
dolphinese.” — Carl Sagan.
CaseFinder is all about words. Words have meaning. Our basic premise is that certain
words are likely to be used in any document discussing certain topics. When we refer to
“words” in this Manual, we also mean numbers; they are treated alike. CaseFinder's databases
include indexes of every word in every document in the database — with the exception of a
short list of “noise words” (listed in CaseFinder's help system). Words such as “at” and “the”
were excluded from the indexes because (1) they are extremely common and would take up a
lot of room, and, more importantly, (2) they lack meaning and would not assist the researcher.
The asterisk, known as a global replacement character, serves a special purpose in a
search request. When entered as part of an item (word or number), it will cause CaseFinder to
search for any item whose characters match those characters which precede and/or follow the
asterisk, regardless of which characters, or how many characters, are substituted for the
asterisk. Thus, if you do a search on art*is, CaseFinder will include in the results those
documents which contain the word arteriosclerosis, arteritis, artherosclerosis, arthritis or
arthrodesis. If fenc* is entered as a search term, cases containing fence, fenced, fencerow,
fences or fencing will be included in the search results. Note: The Word List (discussed below)
shows the words which would be included in the search if an asterisk were typed into the
Entry Bar at the present position of the cursor.
The question mark, known as a wild card character, serves a similar, though more
limited, purpose in a search request. While the asterisk allows the substitution of one or many
characters at that position, the question mark allows the substitution of a single character.
Thus, if wom?n is entered, CaseFinder will include in the results those documents in which
woman and women occur. By examining the Word List, you will be able to discern which words
will be included in the search by use of the question mark.
Apostrophes are significant in CaseFinder. Words which contain an apostrophe or
which end with an apostrophe are indexed in that form, and should be entered exactly as they
appear. With Possessives, Plurals and Tenses on, possessives formed with apostrophes will be
automatically included in your search results (see Ch. 6, “Additional Searching Tools”).
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Hyphenated Words can be entered with the hyphen or as two separate words. CaseFinder
ignores the hyphen, treating the hyphenated word as though it were a phrase and locating all
instances where the item preceding the hyphen is immediately followed by the item following
the hyphen, whether or not a hyphen appears between the two parts. This has the advantage
of finding all the documents containing the hyphenated word, regardless of the preference of
the author as to the necessity of hyphenation. However, CaseFinder cannot automatically
search for both variations of words which appear both hyphenated and as a single word, such
as pre-empt and preempt. In those situations, enter both forms connected by OR, or treat both
forms as Synonyms (see Ch. 6, “Additional Searching Tools”).
Word combinations using a slash, such as attorney/client, cannot be entered in the Entry
Bar; the slash instructs the search engine to use word proximity. However, when the indexes
were created, such words were treated in the same manner as those containing a hyphen.
Thus, if you enter the combined word as a phrase, the search results will include instances
where the two words were separated by a slash, a hyphen or a space.

Phrases
In addition to words or numbers, you can enter phrases in your search request, such as
res judicata or harmless error or 206 Va. 924. To enter a phrase, simply type in the elements
of the phrase without a connector between them — don't put the phrase inside quotation
marks (but it will still work if you do). In order to score a “hit,” a document must contain the
phrase exactly as entered, except when the phrase incorporates a “noise word,” discussed
below. A phrase is treated by CaseFinder as an individual item in the search request. Thus, a
phrase can be combined with a word or number in a search request, e.g., res ipsa loquitur AND
liability.
By entering the citation of a case (not its name) as a phrase, you can perform a form of
“Shepardization”™ on a case. For example, searching on the phrase 206 Va. 924 will find all
cases which have cited that case, and you can look at the text of each case to determine
whether 206 Va. 924 was followed, distinguished, etc. This is such a handy function that we
automated it and incorporated it as the CitedIn feature in the Document Viewer (Shortcut:
Type in the citation of a case, click on the Direct to Document button, click on the CitedIn
button.)
If a phrase includes a “noise” word (e.g., “at” in men at work), CaseFinder will not try to
find a match for the noise word, but will instead treat the phrase as a proximity search in
which the words before and after the noise word are within one word of each other. In this
situation, any other word could appear in place of the noise word. Thus, a case containing the
words men began work could be listed in the results of a search for the phrase men at work.
Do not use the words “and,” “or” or “not” in a phrase. CaseFinder always treats these
words as connectors between items in your search request (discussed below). If you need to
look for a phrase that normally contains such words, use the Within 3 Words proximity
connector instead. For example, a search on the phrase rough and ready would find all
documents in which the word rough and the word ready are located anywhere in the docu-
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ment. Although you can't narrow the results to just those cases which contain the exact phrase
rough and ready, you can narrow the results to those cases where ready is the second word
after rough (or vice versa) by searching on rough w/3 ready. In addition, the word “contains”
has a special meaning to the search engine and cannot be used in search requests.
Individual words within a phrase can contain global replacement character (*) or wild
card character (?) discussed above. For example, a search for tax* authority would find
documents containing the phrase taxing authority, taxation authority, etc.

The Word List is Your Friend
When you enter the third letter of an item in the Entry Bar, the Word List drops down,
showing the words in the selected database that begin with the letters you’ve thus far entered.
(You can set the number of characters to type before the Word List appears, and the number
of words the Word List displays; see Ch. 12,
“Customizing CaseFinder.”) As you enter
additional characters, the Word List adjusts,
showing, in alphabetical order, those words
which begin with whatever you’ve typed in. If
you've typed in three or more letters, and
nothing matches what you’ve typed in, the
Word List goes blank (discreetly suggesting
that you’ve entered a typo). Note: The Word
List is not functional when you are performing
a multiple database search; the time that would
be required to determine whether the word you
are entering exists in any of the multiple
databases would be “annoying.”
A number appears to the right of each word in the Word List, showing how many times
the word is contained in the selected database. Note: This is not the number of documents
that contain the word; “20” could mean that only one document contains the word, but it
appears 20 times in that document.

Connectors
Five Connector Buttons appear in a vertical row on the left side of the Search Request
screen. Clicking one of these buttons adds the indicated connector to the search request at the
current cursor location in the Entry Bar. Connectors can also be entered in the search request
by holding down the <Alt> key and pressing the underlined letter on the face of the button.
Experienced CaseFinder users usually type in the connectors.
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Regular Connectors
For most of your searches, you will use the three common Boolean connectors AND,
and NOT. In fact, most of the time, you will probably only use AND.

OR

The AND connector is far and away the most useful connector, because it narrows the
results of your search. AND requires that both the item before the connector and the item after
the connector be present, anywhere, in a document.
Because CaseFinder searches the entire text of the document, every document that
contains words connected by AND in a search request will appear in the results list, even if the
words are so far apart within the document as to have no meaningful relationship. Using this
fine-toothed comb approach, you can be sure that you will not miss a possibly relevant
document. But it is tedious to wade through a long list of cases when many of them are not
relevant, which is likely if the words in the search request are quite common. In this case, one
of the Proximity Connectors (see below) might be used instead to produce more-focused
search results. Another way to focus the search results is to select search terms that are more
specific.
The OR connector b r o a d e n s a search. Unless modified by the placement of parentheses, the items immediately preceding and following the OR connector are treated as synonyms.
Thus, to satisfy the search request child OR infant, CaseFinder would select any document
containing either (or both) of the words child or infant.
If the OR connector is used in conjunction with the AND connector, parentheses should be
inserted in the search request to define the effect of the OR connector. See the discussion on
the next page.
The NOT connector excludes a document which would otherwise be included in the
search results if the document contains the item following the NOT connector. For instance, to
satisfy a search request for subpoena NOT duces tecum, a document must contain the word
subpoena, but if a document also contains the phrase duces tecum, the document will be
excluded from the search results. Be careful! The NOT connector can have unintended results.
The word you exclude may be mentioned in a document which is otherwise relevant.

Proximity Connectors
Two Within Words buttons provide proximity searching to make your search request
more precise. Proximity searching requires a word to occur within a certain number of words
before or after another word. Initially, these buttons are labeled Within 3 Words and Within
100 Words. On the right edge of each button is a pair of spin buttons which you use to set the
maximum number of words separating the items. The up spin button increases the number;
the down spin button decreases the number. The Within 3 Words button is incremented by
one; the Within 100 Words button, by ten. To satisfy a proximity request, the items can be
found in either order, as long as they occur within the selected number of words of each
other. All words count, and adjacent words are within one of each other.
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A search request can contain more than one proximity connector, for example,
findings w/2 fact and prosecution w/20 law. Notice the format of the proximity connector in
the search request; a “w” followed by a forward slash followed by a number — it's easy to
type proximity connectors.

Parentheses Rule!
Parentheses control the order in which CaseFinder will process the items in a search
request. Items within parentheses are processed first. When parentheses are “nested,” the
“deepest” items are processed first. Consider this ambiguous search request:
fool OR attorney AND himself OR client
Parentheses add precision:
fool OR (attorney AND (himself OR client))
In this situation, CaseFinder will locate any document which contains the word fool,
along with any document which contains the word attorney as long as that document also
contains either the word himself or the word client.

Saving Search Requests
When a search request produces results, it is automatically added to a list called Prior
Search Requests This Session which is available in the Search Requests tab at the Search
Request screen. The list is retained only until you end the session by exiting the CaseFinder
program, or until you click on New Session at the File Menu of the Search Request screen. The
list contains all your search requests from the current session, the most recent requests listed
first.
If you’ve found a particularly productive
search request and want to save it for use in
future sessions of CaseFinder, select it in the
Prior Search Requests This Session list, then
click the Add to Archive button at the bottom
of the panel and it will appear in the Archived
Search Requests list. You can copy a search
request from either of these lists into the Entry
Bar by clicking on it; double-click on a request
in its list to launch the search. To remove a
search request from a list, select the offending
item; then click the Delete from Archive button.
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Chapter Six:
Additional Searching Tools
Chapter 3 showed you how to do simple searches. Chapter 5 showed you how to enter
special characters and powerful connectors in the search request. This Chapter discusses
searching features that are not implemented within the search request itself, including the
items in the Settings panel on the Search Request Screen, Search Subset, and how to find a
word within the text of a document in the Document Viewer.

Possessives, Plurals and Past Tenses
An option in CaseFinder lets you automatically include regularly-formed possessive,
plural and past-tense forms of the words in the search request. By “regularly-formed”, we
mean adding an apostrophe-s (or an apostrophe if the word ends in “s”) to form the possessive, adding an “-s” or “-es” to form the plural, and adding a “-d” or an “-ed” to form the
past-tense form of a word. For example, a search for judge can automatically also include the
words judge's, judges and judged. This option is turned on by default, and can be turned off
or on by clicking in the “Possessives, plurals and tenses” check box in the Settings panel at
the Search Request screen. When the Possessives, plurals, tenses box is checked, it automatically applies to all of the terms in your search request.

Synonyms
The Synonyms feature augments your search by automatically including synonyms
which you define for items in your search request. Let’s say that you want CaseFinder to treat
the words automobile, vehicle, car and truck as synonyms. That is, whenever one of these
four words is entered in a search request and the Synonyms check box is checked, CaseFinder
will automatically also search for the other three words.
In order to use Synonyms, you'll need to create a Synonym Group. We'll illustrate by
creating a Synonym Group for the vehicular items above. First, select Synonyms from the
Tools menu at the Search Request screen, or click the Edit button beside the Synonyms entry
in the Settings panel.
The Synonyms window is blank the first time you use it. Start by entering any one of the
words in the group of synonyms above (let's do automobile) in the New Word blank. This
enables the list box labeled “is a synonym of . . . .” Choose “-Start New Synonym Group-”
and click the Add button, as shown on the next page. Now type vehicle in the New Word
blank and choose automobile from the “is a synonym of . . .” list and click Add. You can
enter several words, phrases or acronyms, delimited by commas, at one time to quickly create
a Synonym Group.
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When a word in the list on the upper left of the Synonyms
window is highlighted, its synonyms appear in the window on the
upper right. To delete a single word, highlight it in the list on the
left and click Delete. To delete a word along with all of its sibling
synonyms in the Group, highlight the word in the list on the left
and click Delete Group.
The status of the Synonyms feature is determined and
displayed in the Synonyms check box in the Settings panel of the Search Request screen.
When the box is checked, this feature will automatically apply to any word in the search
request which is a member of a Synonym Group.

Time Frame
CaseFinder normally returns all documents found in response to a search request,
regardless of age. You may want to limit the results of your search to only those documents
which were issued after a particular date, or possibly between certain dates. You can use the
Time Frame feature in the Settings panel at the Search Request screen to do this. When the
Time Frame check box is unchecked, the word “Unrestricted” appears beneath it, meaning
that CaseFinder imposes no constraints on the age of the documents it retrieves. Click on the
check box, and a pair of dates will appear beneath, indicating the range within which a
document must fall in order to appear in the Search Results List.
To change the range of dates within which documents must fall, click the Time Frame
Edit button; a window will pop up. Use the spin buttons to set the month, day and year for the
“before” and “after” dates. To retrieve all documents before a given date, set the “after” year
to 1700 by typing in the box or using the spin button. Click OK when you've set the dates.

Name Filter
This feature “filters” the results of a search request so that the Search Results List
includes only those documents whose names (or, for statutes, whose catchlines) either include
or exclude a word or phrase that you specify. Note: this feature works in conjunction with a
search request to limit the results (if you simply want to find a case or code section based
upon a word in its name or catchline, use the Search Names feature, discussed later in this
Chapter). Activate the Name Filter by clicking its check box in the Settings Panel of the
Search Request screen. If no filter was previously entered, a pop-up box will appear, which
you use to enter a filter — illustrated below. The description of a previously-entered filter
appears under the check box when it is checked (for example, “Exclude Commonwealth”). If
the description of a filter is lengthy (for example, “Include Maladjusted Programmers
Society”) it will be cut off, but if you let your mouse pointer “hover” over the description for
a second, the full description will pop up in a little “tool tip” window.
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In this example, the user wants to find cases about
uninsured motorist coverage in which one of the major
insurance companies was a party. The user has entered
“State Farm” as the filter, and has checked the include
option.
The Name Filter is not case sensitive (i.e., it ignores capitalization). It supports the use
of all the elements of a regular search request, including connectors, parentheses, synonyms,
the global replacement character and the wild card character (see Ch. 5). This feature remains
active until you turn it off in the Name Filter check box.

Search Subset
The Search Subset feature allows you to perform a search within your original search
results. Let’s say you ran a simple search and after reviewing your search results realized that
adding another search term would have helped limit your results. With Search Subset you
don’t have to start your search from scratch. Enter another search request into the Entry Bar at
the top of the Search Request Screen and click Search Subset. CaseFinder will search only the
documents from your original search results for the new search term and return the new
results. Search Subset can be ran multiple times to continue to limit search results with new
search terms. Some users like the fact that only the new search term is highlighted in the
resulting documents.
If you searched on multiple databases in your original search request, you may also
choose to exclude some of these databases before you run Search Subset. To exclude some
databases from your search, click on the Databases tab and single click on any database that
you do not want CaseFinder to search on. You can then enter your new search request and
click Search Subset.

Searching in the Text in the Document Viewer
The Find in Text feature lets you search the text of a document in the Document Viewer
for a specific word (or words) or number. Select Find in Text from the Edit Menu to open up
the Find screen, then simply type the word or phrase you want to find in the entry bar and
click Find Next. The Find in Text function normally ignores capitalization; check the Match
Case option if you wish to match upper and lower case letters. Note: To generate a hit with this
function, letters, numbers and punctuation must match exactly.
In this example, the user is looking for “love in all the wrong places.” When he clicks
Find Next, CaseFinder will take him to the first occurrence of that phrase in the document
currently in the Viewer and highlight it. He clicks Find Next
again (Shortcut: press F3) to go to the next occurrence. When
there are no more occurrences, a message box pops up so
stating. The user sighs, chooses another document, and
keeps looking for “love in all the wrong places” by pressing
the F3 function key . . .
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Find in Text finds exact matches. Thus, if you type in place the Find feature will find,
among others, replacement because the letters p-l-a-c-e are contained within it. Hint: put a
space before or after the word you’re searching for — spaces count just like letters — but if a
word is the first word in the document, the last word in a sentence, or is followed by a punctuation mark, a space in the search request may cause it to miss that hit.

Search Results Display Order
A drop-down list box near the bottom of the Settings panel lets you choose the order in
which the results of a search will be displayed. Note that regardless of which type of display
order you select, documents found in statutory-type databases (those which bear a black book
icon) will always appear at the top of the Search Results List.
Database by Date is the default order. If you are searching a single database, cases
appear in reverse chronological order (i.e., the most recent decision appears at the top of the
List). When you've searched on multiple databases, cases will be grouped by the database in
which they were found, with the database groups appearing in the order shown by the open
books in the Database List. Within each database group, the cases will appear in reverse
chronological order.
Mixed by Date. This choice will have no apparent effect on a single database search
(see above). However, if you've searched on multiple databases, this choice will arrange all of
the documents by date, regardless of which database they came from.
Real Ranking. This choice arranges search results in the order of their “relevance” to
your search request. In CaseFinder, the determination of relevance considers more than just
statistics. Three factors, Hit Density, Age and Precedential Value are calculated, and the
document with the highest score out of the group appears at the top of the List. Hit Density is
based on the number of hits in the case and the number of total words in the case; a higher hit
density increases the relevance rank. Age is based on the decision date; a newer case gets a
higher relevance rank. Precedential Value is based on the number of times the case has been
cited by other cases; the higher the number of citing cases, the higher the relevance rank.
Initially, these three factors are given equal weight in determining rank. You can set the
weight given each factor using the Relevance tab in the Options selection of the Tools menu.
Real Ranking Plus. This choice adds a fourth factor, Enhanced Precedence, to the three
factors considered in Real Ranking above. The weight given Enhanced Precedence is also
adjustable at the Tools > Options > Relevance tab. We could tell you how it works, but then
we'd have to kill you. Take Note: Enhanced Precedence takes a very long time, especially
when the databases are on a CD. Not for the faint of heart.

The Seamless Web
Every month, new CaseFinder CDs are mastered, containing new decisions and slip
opinions issued through the end of the prior month. If you are an annual subscriber, you'll
receive your new CDs on or about the 20th of each month. In the meantime, however, those
judges are busy cranking out opinions. All new decisions, in all the CaseFinder databases, are
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posted to a website that is accessible only to CaseFinder users and only through the
CaseFinder program, usually within 48 hours of being issued. The databases on the website
have the same names and cover the same jurisdictions as the databases on the CaseFinder
CDs, except that they contain more recent materials.
Note: You must already have access to the web in order for this feature of
CaseFinder to work. You do not use your browser to use this feature, but CaseFinder
accesses the web through your existing internet connection. If your computer does not
connect to the internet automatically when a program requests, you must connect prior to
using the web feature of CaseFinder.
The drop-down list box at the bottom of the Settings panel in the Search Request screen
provides three choices as to whether and when CaseFinder will access the website during a
search. The first choice, Search CD, means that the only databases that you will be working
with are those that are either on your computer (on the CDs or installed on your hard drive) or
on a network to which your computer is connected.
The second choice, Search CD & Web, seamlessly integrates the databases on the
CaseFinder website with the databases on your computer or network. This choice works best
if you have a broadband connection to the web rather than a dial-up connection. Under this
setting, when you run a search, CaseFinder will first send the search to the databases on the
website and then run the search against the databases on your computer or network. Before
displaying the results, it will get the results of the search on the website. When the results are
displayed in the Search Results List, those cases that were found on the website will be
displayed at the top of the list, and they will bear a little world icon. When you double-click on
a web document, it will appear in the CaseFinder Document Viewer, not your web browser. In
fact, other than the web icon, you won't be able to tell that the document came from the web
rather than the CD. Relevance Ranking is disabled when you are operating in this mode. Using
this mode with a dial-up connection may be unsatisfactory because of the delay in receiving
results from the CaseFinder website.
The third choice, Search Web, lets you run Search Requests or use the Library only
against the databases on the website. This will probably be a better way to use the web site if
you have a dial-up connection. Typically, you'd first select Search CD, run your search
request, examine cases, place documents on the Keep List, etc. When you're through with that
part, switch to Search Web and run the search again, this time on the databases on the
website, as a way of checking to see if there are any later cases of importance.
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Chapter Seven:
Using Lists
Your research will produce groups or collections of documents. For instance, running a
search produces a group of documents that satisfied the search request. Clicking on the
CitedIn CD or CitedIn Web buttons produce a group of cases that cite the current document.
As you work through a research project, you may want to collect documents of particular
relevance in one place. CaseFinder displays some of these groups in one of several “Document Lists.” You create other “Document Lists” by placing documents on them. This Chapter
discusses the features common to all of these document lists, and explains the role each plays
in the research process.

CaseFinder Document Lists
Lists are a common feature of Windows programs; CaseFinder uses them in a number of
places. Six lists are integral to the selection and retrieval of documents from the CaseFinder
databases: the Databases List, the Search Results List, the Library List, the Keep List, the
CitedIn List and the History List. To differentiate these “document lists” from ordinary lists,
we will capitalize the word “list.” The first part of this Chapter will discuss features common
to one or more of these Lists, after which each of the Lists will be discussed in greater detail.

Common Features of Document Lists
These six Lists share certain features and abilities. Each item in the Lists is identified by
one of four icons: a book icon, a document icon, a web book icon or a web document icon. If
the item bears a document or web document icon, it will be followed by its name and citation
(and sometimes additional information); double-clicking on it will open the Document Viewer
and display the text of the document. If the item bears a book or a web book icon, it will be
followed by the name of a collection (e.g., titles, chapters, subdivisions, etc.); double-clicking
on the item will display its contents, which may be documents, but could also be additional
volumes, chapters, subparts, articles or other subdivisions.
All Lists contain two or more columns. The nature of the information in a column is
described in its header. The width of a column can be adjusted by placing the mouse pointer
on the line between column headers, then clicking and dragging to adjust their width. This is
handy when the text in a column is too wide to display in its entirety. If a horizontal scroll bar
appears at the bottom of the List, all or part of one or more columns is not visible; narrow the
visible columns to pull the information into view, or use the horizontal scroll bar to slide over
to it.
Generally, one of the items in a List is highlighted in a selector bar. You can move the
selector bar to a different item with the up or down arrows, the <Page Up> or <Page Down>
keys, the <Home> or <End> key, the scroll bar, the mouse wheel, or by clicking on a differ-
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ent item. Shortcut: Pressing a letter key on the keyboard will take you to the next item down
the List that starts with that letter, starting over at the top of the List when the end is reached.
If the selected item has a document icon, pressing <Enter> or double-clicking on it causes the
full text to be displayed in the Document Viewer. If the selected item has a book icon,
pressing <Enter> or double-clicking on it will display its contents.
In addition to selecting and opening documents, some or all of the Lists share other
common functions. All Lists have a Return to Document button; clicking it when it is enabled
returns you to the Document Viewer, displaying whatever had been there when you left it. All
Lists also have a Print List button; clicking it sends the List itself (not the text of the documents in the List) to the printer. When a List is printed, additional information about the items
on the List will be printed, along with the current date and time (see Ch. 10, “Printing").
Several Lists (Library, Keep and CitedIn) have a Print All button. Clicking on this
button when it is enabled will cause the text of all of the items on the List to be printed — be
sure you have enough paper loaded in the printer before you click!
The Search Results List and the Library List both have a Fast Forward button. When a
highlighted item in the List has a book icon, clicking the Fast Forward button takes you
directly to the first of the documents contained
in that book, bypassing any intervening subparts or book icons, and lists all of the documents contained within that book. For example, if you search on “military” in the Va. Code,
the Search Results List shows 41 titles that
contain hit sections, including Title 44 with 170
hits.

If you double-click on Title 44, the next
List will show five Chapters within Title 44 that
have hit sections (double-clicking on a Chapter
will bring up a List of Articles, etc.).
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If, instead, you click on Fast Foward when
Title 44 is highlighted, you will go directly to a
List of all 170 sections in Title 44 that were hit,
and almost immediately the first section in the
List will be displayed in the Document Viewer.
The Search Results List and the Library List
also have a Back button. When the items in a
List were derived from an item which bore a
book icon, the Back button will take you back
to that “level.”

How the Document Viewer
Works with Lists
You will usually be working from a List when you are viewing documents in the
Document Viewer. The Source panel to the left of the Document Information Bar always
displays the source of the text being viewed. If the source is a List, the name of the List is
shown, along with the total number of documents on the List and the position of the current
document on that List, e.g: Search Results 1/170.
Whenever you're viewing a document from a list, clicking on the Next Doc button, or
pressing <Alt-X>, brings up the next document on the list; clicking on the Prior Doc button,
or pressing <Alt-P>, brings up the prior document on the list. If you're looking at the first
document on a list, the Prior Doc button is disabled; likewise, when you're looking at the last
document on the list, the Next Doc button is disabled.
You can switch to a different List at any time. Five buttons on the Document Viewer
bear the captions Library List, Search List, CitedIn List, Keep List and History List. When the
caption of any of these buttons is enabled (black text), that List has documents on it; if the
caption is greyed out (disabled), there are no documents on the List. Clicking an enabled
button displays that List. Each List contains a Return to Document button which will take you
back to the current document.
If you open a document from a List: (1) That List is now referred to in the Source panel;
(2) The chosen document appears in the Document Viewer; and (3) if you had been viewing a
hyperlinked document, it and any hyperlinks that led up to it, are lost. Well, not lost lost —
they're still on the disc, and they can be accessed from the History List (see below at page 36).

The Database List
A major enhancement in this version of CaseFinder is the ability to search multiple
databases at one time. Selecting databases for inclusion in a search is done at the Database
List, illustrated on the next page:
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The Database List is always displayed
when you start CaseFinder. All of the databases that are on your CaseFinder CDs are
shown in this list. Depending upon how you
installed CaseFinder (see Ch. 2, “Installation
and Updating”), not all of the databases are
immediately available. Those databases which
are immediately available (because they are on
the CD currently in the CD-ROM drive or they
were transferred to an accessible hard drive)
are shown in full living color; databases
which are on a CD (or hard drive) that is not currently available are shown “greyed out” (if
CaseFinder needs to access a greyed-out database, you will be prompted to either insert that
CD in your CD drive or provide the location of the database).
The entry for each database is preceded by a book icon. Tan books represent case law;
black books represent statutes, constitutions, rules, etc. To include a database in a search
request, click on it, or move the selector bar to it and press <Enter>. When you do its book
icon will open and the word “Yes” will appear in the column labeled Search. Databases with
opened book icons will be included the next time you run a search request. To exclude a
database from the search request, click on it or highlight it and press <Enter> and the book
icon will close. Buttons at the bottom of the Database List let you Open All, Close All, or
Refresh the databases.
The default order in which search results will be displayed in the Search Results List is
“Database by Date.” This means that the search results will be grouped by database, and
within each database, they will be arranged in reverse chronological order. The databases will
appear in the same order as shown by the order of the open book icons in the Database list.
Note that when selected, statutory databases (black book icons) always precede any judicial
databases (tan books) at the top of the Search Results List.

The Search Results List
When it completes a search, CaseFinder displays information about the documents that
satisfied the search in the Search Results List. The manner in which information about a
document is displayed depends upon the type of database in which it was found. If the
document is a judicial decision, a “document” icon will appear (or possibly, a “web document” icon), followed by the name of the case (or other information identifying the document), the official citation, and the number of “hits” in the document (or, if the results are
being displayed by relevance ranking, a percentage figure — see Ch. 12, “Customizing
CaseFinder”). Double-clicking on that item will open it in the Document Viewer.
If the document came from a database of statutory or constitutional provisions, rules,
regulations, etc., the initial Search Results List will display the first “level” of subdivisions
within that database which contains hit documents. An example will help. At the time this
manual was written, a search on the Virginia Code for “military” found 387 hit sections in 41
different titles; of these, Title 44, “Military and Emergency Laws,” contained 170 hit sections.

32

When you're searching statutory databases,
you generally have a preconceived idea of
which subdivisions (titles, chapters, subparts,
etc.) will contain relevant documents. In
addition, the names of the subdivisions are
useful clues as to the applicability. By first
displaying the subdivisions, CaseFinder lets
you get to the good stuff more quickly (more
on that below). Consider: In our example, if
CaseFinder had simply displayed all 378 hit
sections in the order in which they occur in the
Va. Code, you would have to scroll down 152
sections to find the first section occurring in the title on Military and Emergency Laws.
In the illustration above, if you doubleclick on Title 44, the next screen will display the
five Chapters of Title 44 that contain hit
sections. If you double-click on Chapter 1 Military Laws of Virginia, the next screen will
display the sixteen Articles of Chapter 1 of Title
44 that contain hit sections. If you double-click
on Article 1 - Classification of a Militia, you will
get a list of eight hit sections. They have
document icons, so double-clicking on any of
them will display the full text in the Document
Viewer.
Notice in the illustrations above that as we “walked” down through the subdivisions of
the Va. Code, the steps on our pathway were set out in the top part of the panel. On your
computer these topic outline descriptions will appear highlighted in the same color you choose
for your hyperlinks (See Ch. 12, “Customizing CaseFinder”). When you point to any of them,
the pointer changes into a little hand, and by clicking on them, you will jump back up the topic
outline to that topic. Notice also, at the bottom of the panel, the Back button is enabled, which
will take you back up the topic outline one “level” at a time.
Perhaps you're not a patient person? The Fast Forward button is your solution (and
you're probably irritated that we took this long to tell you . . .). Let's go back to the first result
screen in our example above, the one that showed the 41 titles of the Va. Code. Highlight Title
44 - Military and Emergency Laws and click on the Fast Forward button. CaseFinder will
generate a list of all 170 hit sections contained within that Title, and open the first one in the
Document Viewer.
Fast Forward can be launched from any level. In the first screen of our example, you
could double-click on Title 44, generate the screen showing five Chapters, then highlight
Chapter 2 and click Fast Forward. CaseFinder will generate a list of the six hit sections within
that Chapter and open the first one in the Document Viewer.
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The CitedIn List
When a document is displayed in the Document Viewer, the CitedIn CD and CitedIn Web
buttons will identify any cases in CaseFinder that cite the current document. The CitedIn CD
button will indicate whether any case in any of the judicial databases on the CaseFinder CDs
have cited that item. If the CitedIn CD button is enabled (black) then the document has been
cited by at least one case in the CaseFinder databases; if it’s disabled (grey), it hasn’t been. The CitedIn
Web button will always appear to be enabled (black).
To check if any recent cases have cited your current
document, click on CitedIn Web and CaseFinder will
check our website and return the results of the web
search. A message will be displayed if there are no
web documents that cite the current document.
(Note: This does not mean that the document hasn’t
been cited by cases from jurisdictions not included
on the CaseFinder CDs or on our website. Also note
that the databases on the CaseFinder discs include those courts with overruling authority.)
When you click on the CitedIn CD or CitedIn Web button, a list of cases citing the
document you are viewing will appear. Unlike Shepard's® we don't tell you what the citing
court said or did (we also don't charge as much). Instead, we make it quick and easy for you to
check every citing case to see exactly what was said and whether it affirmed, distinguished or
overruled the document in question. Move the selector bar to a case in the CitedIn List and
press <Enter>, or double-click on a case. If the database containing that case is not immediately available, you will be prompted to insert the other CD in the CD drive, or to provide the
location of the database. If the database is immediately available, four things happen: (1) The
text of the citing case appears in the Document Viewer; (2) The CitedIn List becomes the list
referred to in the Source panel; (3) The CitedIn List button in the Document Viewer becomes
enabled; and (4) Had you been viewing a hyperlinked document, the return links in the chain
of hyperlinks will be lost (although the documents in the chain of hyperlinks will be available
from the History List, discussed below at page 36).
By default, CaseFinder opens documents at the beginning. When the document contains
hit words from a search request, a button on the Document Viewer labeled Hits Down will be
enabled; when you click on it, CaseFinder takes you down to the first instance of the hit word
in the document and highlights it in a color you have chosen. There is also a button labeled
Hits Up that does the same thing in the other direction. When you are viewing cases from the
CitedIn List, the Hits Down and Hits Up buttons get renamed Cite Down and Cite Up. When
you click on them, CaseFinder takes you directly to the citation of the case being cited and
highlights it. Instead of opening the case at the beginning, you can set an option to open
cases at the first occurrence of a hit word, or when you're working with the CitedIn List, to
open cases at the first occurrence of the cite. (See Ch. 12, “Customizing CaseFinder.”)
When you open a case from a CitedIn List, the list is saved for later use and you can
return to it by clicking the CitedIn List button. Only one CitedIn List can be stored in memory
at any one time. (This is for your own good — trust us.) You can view the CitedIn List for
other documents, but if you decide to open one of the cases, you will be notified that you will
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overwrite the CitedIn List from which you last accessed a document, and you will be given the
option of proceeding or canceling.
When the CitedIn List is on the screen, you must either click one of its buttons, or open
a case from it before you can do anything else in CaseFinder. One of the buttons on the
CitedIn List screen is labeled Return to Document, so you can always get back to where you
came from. As with the other Lists, one of the buttons on the CitedIn List is labeled Print This
List. The citation of the case being cited by the cases on the list appears in the caption of the
CitedIn List; if you need to re-read that case, open one of the citing documents, click on Cite
Down and you can hyperlink to the case (even though it is highlighted as a hit instead of a
hyperlink).

The Keep List
The Keep List is an exclusive feature of CaseFinder. Legal research usually involves
looking at a lot of documents, only a portion of which will be relevant. The Keep List provides
an easy way to collect those documents which seem to be important. You create the Keep List
by placing documents on it. When any document is being viewed in the Document Viewer, it
can be added to the Keep List by clicking on the Keep
button, or by pressing <Alt-K>. The only thing you
will notice when you do this is that the caption of the
Keep button will turn from black to grey, and, if this
is the first document placed on the Keep List, the
caption of the Keep List button will turn from grey to
black, indicating that it now has a document in it.
Note: If you view a document that has already been
placed on the Keep List, the Keep button will be
greyed out.
Any time the Keep List button is active, clicking on it, or pressing <Alt-E>, will bring up
the Keep List. Documents will be listed by name, citation and source. If you open a document
from the Keep List, three things happen: (1) The text of the kept document appears in the
Document Viewer; (2) The Keep list becomes the List referred to in the Source panel; and (3)
Had you been viewing a hyperlinked document, the return links in the chain of hyperlinks will
be lost (although the documents in the chain of hyperlinks will be available from the History
List, discussed below).
The Keep List (unlike any other List) has a Delete button. Place the selector bar on an
item in the Keep List and click on the Delete Item button to remove it. The Keep List also has
a Clear List button, which deletes all of the entries. Selecting New Session from the File menu
at the Search Request screen will also clear the Keep list, as will exiting CaseFinder.
The Keep List retains its contents until you clear it or until you exit CaseFinder, as
noted above. That way, you can perform a search on one database, add some documents to
the Keep List, switch databases, perform another search, and add documents to the same
Keep List.
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The Keep List has enhanced printing capabilities. As with other Lists, the Keep List has a
Print This List button to print the List itself. However, the Keep List also has a Print All button;
click on it to print all the documents on the Keep List. Be sure you have enough paper in the
printer when you do this. If you realize, after clicking Print All, that you've made a terrible
mistake (like, you're sending 1,126 documents to the printer), save some trees. Double-click on
the little printer icon down in your Windows System Tray to open the Printer windows, then
select Purge Print Documents from the Document menu.
CaseFinder allows you to save Keep Lists. After adding documents to a Keep List, click
on the Keep List button to open the current Keep List. To save this list, click on Save as…
Windows will prompt you to give your Keep List a file name. Enter a clever name to help you
remember what is on the Keep List and click Save. CaseFinder saves the Keep List in your
CaseFinder Users folder so you can access it later. To start a new Keep List click on the Clear
List button from the Keep List. You are now ready to start saving documents to a new Keep
List.
To access a saved Keep List click the Open button on the Keep List. CaseFinder will
display the Keep Lists saved in your User folder. Select the Keep List you would like to open
by clicking on the Keep List name and then Open. The saved Keep List will appear and you
can now view, delete or add documents to this list. Don’t forget to save your Keep List again if
you make changes.

The History List
Our latest (if and when you need it, you'll say greatest) feature is the History List. The
History List records the name, citation and source of every document you've opened in the
Document Viewer in the current session of CaseFinder, in the order in which you opened them.
If you open a document more than once, it will be listed more than once.
The History List was designed to be a “lifesaver.” Say you've been doing some research for a
long, long time and all-of-a-sudden it dawns on you
that you need to see something that you didn't save
on the Keep List, the name of which you can't
remember — the History List rides to the rescue. Open
the History List; the first item in the list is the first
document viewed in this research session. Doubleclick on the first item, and you can then work your
way forward with the Next Doc button, through every
document — it's like déjà vu all over again! The
History List is cleared when you exit CaseFinder, or you can clear it by choosing New Session
from the File menu at the Search Request screen.
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The Library List
The Library is always open in CaseFinder.
Its home is under the Library tab at the Search
Request screen; if you're in the Document
Viewer, click on the Library List button. When
the Library List opens, all CaseFinder databases on the CaseFinder CDs will be listed. Those
which are immediately available (either on a CD
in an available CD drive, or on an available hard
drive, if you have transferred databases to hard
drives, see Ch. 2, “Installation and Updating”)
will be displayed in full living color; accessing databases which are greyed out will require that
you put the appropriate CD in a CD drive or provide a location for the database if it's on a hard
drive.
Notice that in the initial Library List, the icon for each database is a book. As discussed
earlier (see “Search Results List,” above), book icons represent containers. The contents may
be documents, represented by document icons — or more book icons, representing volumes
or other containers, such as titles, chapters, subparts, etc.
Databases of judicial opinions (represented by tan book icons) are usually subdivided
into volumes, or in the case of unpublished decisions, years or jurisdictions or some other
logical division. When you double-click on this type of database, the next screen will list the
volumes or subdivisions in the database. Double-click on the volume that contains the desired
document, and the next screen will list the cases (represented by document icons). Doubleclick on the case you want to open in the Document Viewer.
Databases of statutes, constitutional provisions, etc. (anything represented by a black
book icon) usually contain several levels of containers or subdivisions, each of which will be
represented by another black book icon. Keep clicking those icons until you work your way
down to the statutes themselves, represented by document icons. As you work your way
down through the subparts, note that a hierarchy of subdivisions appears above the List as a
series of hyperlinks; click on one of them to go back “up” to that level. Also note, as you
work down into the subparts, that the Back button at the bottom of the List, when enabled,
will take you back “up” one level at a time. Note that the Fast Forward button (see page 33,
above) is available in the Library List whenever the List contains document, as opposed to
book, icons.
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Chapter Eight:
Hyperlinking
CaseFinder has extensive hyperlinking capability. Whenever a citation to a document
contained in the CaseFinder databases appears in the text on the screen, it is highlighted.
Place the cursor on the highlighted text (it changes into a little hand) and click. After a brief
pause, the text of the cited document appears in the Document Viewer. CaseFinder has taken
hyperlinking one step further; when the citation is to a particular page within a case (a “pinpoint” citation), clicking on it will take you directly to the cited page.

How to Hyperlink
CLICK ON THE HIGHLIGHTED
...

CITATION

. . . TO VIEW THE DOCUMENT

When you are viewing the text of a hyperlinked document, all of the functions in the
Document Viewer are available — printing, copying, CitedIn, Notes, Find in Text, etc.
Hyperlinks appear in hyperlinked documents, so you can link from one document to the next,
creating a “chain” of hyperlinks, any number of times. In addition, like any other document, a
hyperlinked document can be added to the Keep List. However, there will be no highlighted
search words in the text of a hyperlinked document, because the document was not found in
response to a search request.
The Source panel will tell you that you are hyperlinking, and identify the current
hyperlink in the chain by number, e.g., Hyperlink 3. As you hyperlink from one document to
another, the hyperlink number increases by one. The Back button (see below) takes you back
to the previous document in the chain, decrementing the hyperlink number.
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Unlike other CaseFinder documents, hyperlinked documents do not “reside” on a list.
Consequently, the Next Doc and Prior Doc buttons are disabled when you are viewing a
hyperlinked document. However, hyperlinks have a button all their own — the Back button.
Clicking on Back, or pressing <Alt-B>, returns you to the document from which you initiated
the hyperlink, at the place in that document from which you initiated it.

§ 1. A search on employees w/2 disabilities
in the Va. Supreme Court finds 13 cases,
including 275 Va. 83. Near the middle of the case,
we click on the citation to 251 Va. 186.

2. In 251 Va. 186, we click on the cite to Va.
Code § 65.2-400.
¨

§ 3. After reading Va. Code § 65.2-400, we
click on the Back button.

4. We returned to 251 Va. 186 at the exact
point from which we hyperlinked the second
¨
time. We click Back again.

§ 5. And we're right back to the place in 275
Va. 83 from which we hyperlinked the first time.
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If you call up one of the Lists, and open a document from it, the “chain” of hyperlinked
documents will be lost.

§ In the example above, when we were
looking at Va. Code § 65.2-400, if we had clicked on
the CitedIn CD button, the CitedIn List would
appear. If we then double-clicked on a recent case
listed in the CitedIn list, 263 Va. 365 . . .

The text of 263 Va. 365 would be
¨
displayed in the Document Viewer. Note that
the Document Information Bar informs us that
we’re working from the CitedIn List and that
this is number 1 of 738 documents on the List.
Note also that the Back button is now
disabled. From here, we can no longer get
“back” to Va. Code § 65.2-400 with a single click because we “broke” the hyperlink chain.
When you open a document from a list while viewing a hyperlink, the hyperlinked document,
and those in the “chain” leading to it, will no longer be accessible with the Back button.
However, those documents are available from the History List, or in the alternative, you may
have placed them on the Keep List.

Pinpoint Hyperlinking
In addition to standard hyperlinking, as described above, CaseFinder also supports
“pinpoint hyperlinking.” (Another CaseFinder exclusive!) Many case citations “point” to a
discussion that appears on a particular page within a case. Instead of hyperlinking back to the
beginning of the case, CaseFinder will take you directly to the page in the document specified
by the pinpoint cite.
In this illustration, we have returned to
275 Va. 83, used in the first example above. Note
the citation to Stenrich Group v. Jemmott, 251
Va. 186, 192. When you click that hyperlink . . .
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CaseFinder will open that case at the
page cited in the pinpoint hyperlink.

Footnotes
CaseFinder accesses footnotes in a
manner similar to the hyperlink function. When you click on the highlighted, superscripted
footnote number in the text, CaseFinder will jump forward to the text of that footnote. When
you've read the footnote, click on the footnote number to return to the point in the case from
which you accessed the footnote. If you hyperlink to another document from a hyperlinked
footnote, the footnote will become your new “position” in the case. Footnotes are physically
located at the end of the opinion. When there are dissenting or affirming opinions, the
footnotes appear at the end of their respective opinions.

Hyperlinking Without Links
Sometimes while reading the text of a document you will want to quickly look at the text
of some other document, whose citation you know, but that citation doesn’t appear highlighted in the text before you. No problem! With CaseFinder, you can access any document
even though a hyperlink to it is not present in the current Document Viewer window. Select
Hyperlink from the Tools menu at the top of the Document Viewer. A dialog box drops
down. Enter the exact citation of the document to which you want to hyperlink, and press the
OK button. If you aren't sure of the format of the citation, minimize the Document Viewer so
you can see the Search Request screen, click on the Databases tab, and right-click on the
database whose citation format you're interested in. An on-screen menu will appear, with the
citation format shown toward the bottom. Alternatively, minimize the Document Viewer,
click on the Library tab, and open the document from there.
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Chapter Nine:
Copying & Pasting Text
One of the major improvements brought about by the Windows operating system is the
ease with which text can be selected and copied from a document in one application and
placed into a document in another application. CaseFinder uses this functionality to transfer
portions of text from CaseFinder documents into your other applications. This Chapter walks
you through the process of selecting some text, copying it, and pasting it into a word processing application.

Copying and Pasting Selected Text
Let’s assume that you are working on a legal memorandum in your Microsoft Word
word processor. You minimized Word and opened CaseFinder, performed a search, and
you're reading the text of one of the documents you found. You find some language that you
want to quote in your memo.
Open Word and arrange things so that both
the CaseFinder Document Viewer and Word are
visible.

Click and drag to select the desired text.
Let up on the mouse button. Then click and
hold with the left mouse button in the selected
text. The cursor will turn into a circle with a
slash through it, which means that you can't
drop it just yet.
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Keeping the mouse button depressed, drag
the slashed circle off the Document Viewer
window and over your Word window. It will
change appearance when it gets over Word,
becoming a small square with a plus sign,
accompanied by an arrow. If you move this
cursor over existing text in Word, you'll notice a
shadowed I-beam cursor to its upper left — this
is the point at which the selected text will be
inserted when you “drop” it by releasing the left
mouse button.
When the selected text is dropped in your
word processor, the text is fully formatted and
followed by the full citation of the source,
including the name in italics, the official
citation, the page number within the case where
the text appeared, the parallel citation, the page
number in the parallel citation (if available), the
year and the jurisdiction of the case.
Drag and drop works with almost all word
processors. Drag and drop also works with
browser-based e-mail (e.g., Gmail) and with mail
clients like Outlook Express and Thunderbird.
Fully-formatted text followed by the citation can be pasted into word processors that don't
support drag and drop by using the Windows clipboard. Instead of dragging and dropping the
selected text, copy it to the Windows clipboard by selecting Copy from the Edit menu, or by
pressing <Ctrl-C>. Then, go the application into which you want to paste the text and select
Paste from its Edit menu, or (usually) press <Ctrl-V>. The text will be fully formatted and
followed by the complete citation, as set out above, if the application supports certain
Microsoft Windows standards (which WordPerfect for Windows does).
By default, CaseFinder places the citation on a separate line after the quoted material, as
that is the conventional location in briefs and/or legal memoranda. However, you can choose
to append the citation to the end of the quoted material, or to place the citation before the
quoted material — see Ch. 12, “Customizing CaseFinder.”

Printing Selected Text
To print selected text, click on Print from the File menu. In the Print Range panel of the
printer dialog box, click on the “Selection” option, then click the OK button.
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Chapter Ten:
Printing
Documents printed from CaseFinder look professional. You can choose the font and size
of the type, set the margins, select justified or normal text, choose normal or two-column
printing and enable or disable widow/orphan control. You can select text from a document
and print just the selection. Most Lists in CaseFinder can be printed. When you have a list of
documents on the Library List, Keep List or CitedIn List you can print all of the documents
with a single click.

Setting Printing Options
You can set lots of printing options in CaseFinder, and there are three places where you
can do it. Let's start at the main one by selecting Options from the Tools menu (in either the
Search Request screen or the Document Viewer) and clicking on the Printer tab. The Printer tab
displays the current printer font, margin settings and whether other options are enabled. Click
on the Change button near the sample font to choose a different font and/or font size. You
can't change the font style (i.e., it will remain as regular) because doing so would hide italicized
or bolded text. If your printed pages are hard to read, try a bolder font or a larger font size. If
you're going to use dual-column printing and/or justified text, you might consider a slightly
smaller font for a better finished appearance.
The middle panel of the Printer tab shows the current settings for the top, left, right and
bottom margins. Click the Change button and a Page Setup window will appear, in which
you can enter a new value, out to hundredths of an inch, for each margin. Notice that the
dotted line in the illustration on the Page Setup window will move when you change the
margins. From this window, you will also be able to choose the size of paper on which you
are printing, the source of the paper to the printer and the orientation of the paper. (This Page
Setup window is also available in the File menu.) Click OK when you're finished.
Three check boxes in the bottom panel of the Printer tab allow you to enable or disable
justified printing, widow/orphan control (which automatically prevents a single line of text
from appearing by itself at the bottom or top of a page), and two-column printing. In twocolumn printing, the columns are always centered between the left and right margins.
The Page Setup window, mentioned above, is also available from the File menu; it lets
you set the paper size, paper source, paper orientation and document margins.

Printing Documents
When you are viewing text in the Document Viewer, to print the entire document, select
Print from the File menu. A standard Windows dialog box will open, allowing you to choose
a printer, set its properties, set the number of copies to print, etc. If you have selected text in
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the document, the Selection option button will be enabled in the Print window and you can
check that to print just the selection. CaseFinder prints “presentation” quality documents,
fully formatted and ready to hand to the judge, to send to other attorneys or to give to clients.
Each page of the printout identifies the case or statute at the top, and the printout pages are
numbered. A footer on each page informs the reader that the document was printed from
CaseFinder.

Printing Lists
All of the Document Lists in CaseFinder (except the Database List) have a Print List
button. Click on this button to print the current contents of the List itself. The printout will
include a header with the name of the List and the date and time it was printed. If the printout
is more than a page, the header will be repeated on subsequent pages, along with the page
number of the printout. In addition, the printout of the Search Results List specifies the
number of documents found, database searched and search request, and the printout of the
CitedIn List identifies the document being cited by the documents in the List.

Print All
Three of the Lists — the Keep List, the CitedIn List and the Library List (when it is
displaying a list of documents) — include a Print All button. Click this button to print all of
the documents on the List.

Printing Notes
If you are viewing a Note for a document (see Ch. 3, “A Simple Search Request”) in the
Note Viewer, you can print it by selecting Print from the Note Viewer's File menu.
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Chapter Eleven:
Direct Document Access
Sometimes you already know the citation, or some other identifying information, about a
document you wish to view. Running a search on the citation would get all the documents
that contained that cite, but you only want the one document. Four CaseFinder features help
you out: Library, Search Names, Search Cites and Direct to Document.

The Library List
All of the documents in all of the databases that came with your CaseFinder are available
through the Library, as discussed in Ch. 7, “Using Lists.”

Direct to Document
If you know the exact citation of the case or code section you want, then type in the
citation as a phrase (no quotation marks) and click on the Direct to Document button, or press
<Alt-M>. If you're not sure about the format of the citation, go to the Databases List at the
Search Request screen and right-click on the name of the database; a pop-up menu appears,
one item of which displays the format(s) for the documents in that database. You can even
provide Direct to Document with a pinpoint cite, for example, type 515 U.S. 646, 650 and click
Direct to Document and you will go to page 650 of that opinion.

Search Names
Often, you can remember one of the names in the style of a case, along with the jurisdiction, but you won't have the foggiest idea of what the citation was. Or, you might be pretty
sure that the catchline of a code section contains a particular word, but you can't remember
the cite. In such situations, go to the Search Request screen, select the database, type the word
you can remember into the Entry Bar and click on the Search Names button. CaseFinder will
only look at the names of cases or the catchlines of code sections in performing the search,
but all of the searching options such as global replacement characters, proximity searching,
etc. (see Ch. 5, “Power Searching”) can be used in crafting the search request.

Search Cites
If you know a part of a citation, but not the rest, Search Cites can help you out. Unlike
Direct to Document, Search Cites can use the global replacement character (*) and the wild
card character (?). Thus, if you are sure that the case you want is in volume 364 of the U.S.
Supreme Court but you only know that the page was “270-something,” go to the Search
Request screen, choose the U.S. Supreme Court database, enter 364 U.S. 27? and click the
Search Cites button. This is also handy to get to the full text when you're looking at a printed
document that bears a citation such as “Rosenberg, supra, at 277.”
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Chapter Twelve:
Customizing CaseFinder
CaseFinder is loaded with options to let you customize its “look and feel.” Most of the
options can be accessed by selecting Options from the Tools menu at either the Search
Request screen or the Document Viewer. A Dual Screen Viewing Option is available from the
Window menu.

Accessing the Options Panel
Click on Options from the Tools menu at the Search Request screen or at the Document
Viewer. The Options panel will appear, with six tabs across the top. Each tab is discussed
below.

Search
The top portion of the Search tab lets you customize the settings for the Word List (see
Ch. 4, “Formulating Search Requests”). The check box lets you disable the Word List
completely. The “Expand after typing” box and spin buttons let you choose how many letters
to type before the Word List opens up (the default is 3). We recommend against setting it any
lower than that, simply because listing all the words that begin with the first one or two letters
of a word might be entertaining, but hardly useful. The “Limit word list to” box and spin
buttons let you specify the number of words that will appear in the Word List (the default is
50; the maximum is 1000).

Viewer
The second tab at the Options window is labeled Viewer. In the top part of the tab, the
current Viewer font is displayed. To change it, click on the Change button. A standard
Windows font selection dialog box will open, from which you can select any font and font
size available to your computer. You will not be able to change the style of the font;
CaseFinder has to use the regular style so that italicized and/or bolded text will stand out.
After selecting your new font, you can click OK to return to the Options tab, and from there
you can click Apply — while the Document Viewer is open — to see the effect of the font
change.
In the middle portion of the Viewer tab you can choose the colors of the background,
text, hit words, hyperlinks and page numbers in your Document Viewer. Click on the box for the
color you want to set and a little menu pops up, from which you can choose to go back to the
default colors or to pick a custom color. When you click on Custom, a standard Windows
color-picker appears, showing basic colors and any custom colors you've previously defined.
Click on the box with the color you want, or click on the Define Custom Colors button if
nothing quite suits your fancy. Click on OK when you're done, then click on Apply at the
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Options tab to see what you've done to your Viewer. You can't set the foreground/background
color for highlighting text here; for that, go to Start > Settings > Control Panel > Display >
Appearance and pick the foreground/background colors for the Selected Items (note that this
color choice will apply to selected text in all Windows programs).
In the bottom portion of the Viewer tab you can choose the wheel speed (number of
lines per rotary increment) of your mouse's wheel. (If your mouse has a wheel, you can use it
to scroll up and down. If your mouse doesn't have a wheel, don't tell him about this, because
he'll want one too, and then you'll have all that insurance and registration red tape.) Underneath the mouse wheel speed selector, a drop-down list box gives you three choices for the
position of the citation that accompanies clipped material: Following, Attached and Preceding. If you're going to block indent some quoted material, use Following. If you're going to
insert some material within a paragraph, use Attached. If you prefer to provide the citation
first, use Preceding.
Four check boxes appear on the bottom panel. Underline Hyperlinks turns underlining on
or off (note that hyperlinks will not be underlined or highlighted in your printouts, regardless
of these settings). Because footnotes are treated essentially as hyperlinks, and because they
appear superscripted on the screen, we recommend leaving underlining on. The Bold Hits
check box applies a bold font to the hit words; even though you might pick a bright color
above, bold makes them even easier to see, especially if you're using a high resolution monitor
with lots of text on the screen. Another hits option is Margin Hit Markers; this places a colored
triangle in the left margin of any line that contains a hit word.
CaseFinder normally opens documents at the beginning. The two check boxes under
“Open To First Hit” on the right control instruct CaseFinder to open documents at the
location of the first hit (when you're looking at a document found as a result of a search) or
the first citation (when you're looking at a document from the CitedIn list).

Printer
Printer options are explained in Ch. 10, “Printing.”

Relevance
When it lists the results of a search, CaseFinder supports two types of relevance ranking,
“Real Ranking” and “Real Ranking Plus.” The Relevance tab at the Options window lets you
adjust the “weight” given to the factors that CaseFinder considers in determining each type of
relevance. The upper portion of the tab has three sliders, which let you adjust the weight given
to Hit Density, Age and Precedence in determining the relevance ranking assigned to a
document, and thus, the position of the document, on the Search Results list. “Hit Density” is
determined by comparing the number of occurrences of the word(s) in the search request to
the total number of words in a document; a higher hit density moves the document up on the
list. “Age” means the date of the decision; the older the date of the case, the further down the
list it goes. “Precedence” means the number of times the document has been cited by other
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cases in the CaseFinder databases; the more times it has been cited, the higher up the list it is
placed. The bottom slider, under “Real Ranking Plus,” is labeled Enhanced Precedence; it
incorporates an additional method of determining relevance by reference to precedential
weight.

Internet
The fifth Options tab is labeled Internet. You need to fill in information on this tab only if
you access the Internet by way of a “proxy server” through your organization's network. You
will need to obtain the information requested in this tab from your network administrator.

Amendments
The last Options tab is labeled Amendments. The options on this tab allow you to
change how the inserted or deleted text appears in the amendments in the Virginia Code
Archive database. You can choose the color of the inserted or deleted text along with effects
such as bold, italicize, underline or strike-through. To choose the color, click on the box for the
color you want to set and a little menu pops up, from which you can choose to go back to the
default colors or to pick a custom color. When you click on Custom, a standard Windows
color-picker appears, showing basic colors and any custom colors you’ve previously defined.
Click on the box with the color you want, or click on the Define Custom Colors button to create
a Custom Color. Click on OK when you’re done, then click on Apply at the Options tab to see
what you’ve done to your Viewer. Effects settings are changed by simply clicking on the check
box in front of the effect that you would like to enable or disable. These setting can help the
amendment changes stand out in any way you prefer.

Rearrange Databases
Rearrange Databases can be found under the Tools menu at the Search Request Screen.
When you select Rearrange Databases, a toolbar will appear to the left of your database list.
Select the database to be moved by single clicking on it to highlight it. Choose from the top,
up, down and bottom buttons to move the database to the desired position. Click on Done
when finished to close the toolbar.

Dual Screen Viewing Option
If your monitor is set to one of the higher resolutions (1024 x 768, 1152 x 864, 1280 x 1024,
1600 x 1200 or higher), you should try out the dual screen viewing option. Click on Tile
Windows Horizontally or Tile Windows Vertically under the Windows menu at either screen.
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